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An Overview of GW-WINKS Time Series Programs 

GW‐ WINKS is an add-on component of the WINKS SDA Statistical Data Analysis software. It 
utilizes the foundation of the WINKS program to handle data entry and manipulation and provides 
you with access to a number of time series procedures mentioned in the book Applied Time 
Series Analysis (ATSA) by Woodward, Gray and Elliott.   
 
These tutorials describe some of the fundamental procedures you should know to use this 
program. Details about the specific use of the time series procedures are discussed within the 
book.  
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Installation  
The GW‐ WINKS software can be downloaded from the following webpage:  

       http://www.texasoft.com/ATSA 
 

Follow the installation instructions on the screen to download and install the program. When you 
begin GW‐ WINKS for the first time, a dialog box will appear, asking for a key code. Enter the 
code: T858-TENE-KRCR-QJFJ.   After the installation you will be prompted to choose program 
options. Select options you want to change, or leave the default options in place (recommended) 
and choose Ok. You can change these options at any time by choosing Change Setup Options 
from the Help menu.  

For general information on using WINKS, refer to the WINKS SDA Getting Started Guide which 
you can access by clicking on the How to get Started button on the main WINKS Data Editor 
window or by selecting Start/ All Programs/Texasoft/WINKS7/Getting Started Guide. These 
tutorials will help you understand how to use WINKS for general statistical analysis such as 
descriptive statistics. Not all WINKS procedures are available in the GW‐WINKS version, but those 
pertinent to a time series analysis are available. Also, the Help (click on the Question Mark or 
select Help/Help Topics) provides additional information on WINKS procedures.  To display the 
full WINKS Users Guide, in the WINKS main Data Editor page, click on: Help/ Help on the Web, 
and from the displayed web page, click on WINKS SDA Version 7 Manual.  This tutorial can 
easily be accessed while running GW‐WINKS by selecting Time Series Tutorial at the bottom of 
the Time Series Analysis menu. 
 
Tutorials 
GW‐WINKS provides a platform for performing a variety of time series analyses.  In the tutorials 
that follow we illustrate just some of the features and capabilities of GW‐WINKS.  While 
programs are available (for example, stand alone R code, SAS, etc) for performing most of the 
analyses illustrated here, the key feature of GW‐WINKS is that it is designed to assist the student 
or experienced analyst in fitting ARMA-type models to data, examining the quality of these fits 
and features of the model fitted, finding and plotting forecasts, spectral estimates, etc. with ease.   
 
The following tutorials are designed to illustrate some of the features and capabilities of GW‐
WINKS for analyzing time series data.  The tutorials are: 
 

Tutorial 1 – Using GW-WINKS to Analyze a Realization 

Tutorial 2 – Generating Realizations using GW-WINKS 

Tutorial 3 – Using GW-WINKS Graphics (also using the 
                     Attributes Tab) 

Tutorial 4 – Factor Tables 

Tutorial 5 – Preparing Data for GW-WINKS 
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 The native file format for GW‐ WINKS is an .SDA file.  Tutorials 1,3 and 4 are based on time 
series data sets in .SDA format.  Tutorial 2 involves generating data within GW‐WINKS and 
Tutorial 5 illustrates techniques for reading data into GW‐WINKS from other types of data files 
such as Excel (.XLS), .DBF, and text files (.CVS, .TXT, .DAT etc.).   

Note:  All of the data sets used in these tutorials reside in the  WINKS SDA subdirectory.  By 
default, this is the subdirectory that is shown when entering data using the File menu. in GW-
WINKS. 

Tutorial 1 – Using GW-WINKS to Analyze a Realization 

The GW‐ WINKS program provides a time series analysis environment in which you can easily 
perform several time series analysis tasks.  In this tutorial we illustrate some of these features. 

Step 1: Open the SUN.SDA data set (annual sunspot data 1749-1924) by following these steps: 
  a) On the File menu at the top left of the screen, select Open Data Set. 
            (By default the WINKS SDA  subdirectory will be shown.) 
  b)  Enter SUN.SDA in the Filename entry box and click Open.  (You may also select  
  SUN.SDA from the list of SDA files in the subdirectory.)  You will see a spreadsheet-style  
  screen that contains the sunspot data in the first column and is blank otherwise.  This 
  screen is referred to as the Data Editor.  
 
Step 2.  Calculate sample autocorrelations. 
  a)  In the Time Series Analysis menu and select Sample Autocorrelations  
  b)  Select COUNT as the variable for which to calculate the sample autocorrelations and  
            click Ok.  You will see a new column AUTOCORR_COUNT that contains the sample  
  autocorrelations of the sunspot data in COUNT.  

Step 3:  Calculate nonparametric spectral estimates.  (In this step we will compute the 
periodogram and Parzen window estimates.  In Step 6 we will calculate the ARMA-spectral 
estimate based on the fitted model.) 
   a) On the Time Series Analysis menu select Spectrum  
  b) Select COUNT as the variable and click Ok. 
  c) You will see a Spectral Density Estimates selection box.  You can select to plot the  
  Periodogram and up to 3 window-based estimates.  The default selection is to compute  
  the periodogram, along with the Bartlett, Tukey, and Parzen window estimates using the 
  default truncation point 2 ,M n=  which in this case is 26M = .  All spectral estimates 
  are by default in log scale (recommended).  In this tutorial: 
  i) Select Periodogram (This is the default – there is no action required.  To de- 
   select Periodogram you would click on the selection box to remove the check.)   
   ii) In the first menu (that shows Bartlett), scroll down and choose Parzen and  
   leave the truncation point at 26. 
   iii) In the second menu (that shows Tukey) select Parzen again and change the 
   truncation point to 70. 
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   iv) In the third menu again select Parzen and change the truncation point to 10. 
   v)  Select Ok and you will see information in the Output Viewer related to your  
             spectral estimates 
   vi) Select Data View (toward the upper left of the screen) to return to the Data  
            Editor and you will see 4 new variables: PERIODOGRAM, PARZEN1,  
           PARZEN2, and PARZEN3.  
 

Step 4:  Plot the results 
  a)  Select the Graphs/Charts menu 
  b)  On this menu select Line/Time Series Plots 
  c)  On the resulting menu select Line plots one or multiple  
   d)  Select the variables COUNT, AUTOCORR_COUNT,   PERIODOGRAM and PARZEN1,  
       click Add, and then click Ok. 
   e)  You will see the 4 selected plots.  Note that the names of the variables were used by 
        the plot routine to identify the type of variable to be plotted.  Tutorial 3 will show you  
        how to modify graphs to fit your needs. 
 

 

f)  To return to the Data Editor:  On the File menu at the upper left of the plot screen,  
       select Return. 

Step 5:  Identify model orders for an ARMA fit to the data 
  a)  Select AIC on the Time Series Analysis menu to use AIC to pick the model order.   
  b)  Select COUNT as the variable to be analyzed and click on Ok. 
  c)  Select 0 as the minimum AR order and 10 as the maximum AR order.  Also select 0  
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                 and 3 as the minimum and maximum MA orders.  Select AIC and select MLE as  
       the estimation type, and click Ok.  The following output contains the first few lines of  
       the information given by GW‐WINKS which tells us that AIC selects an AR(8) model  
         for the data. 

 
   Gray-Woodward AIC 7.0.3 PROFESSIONAL Edition            October 18,2011 
   -------------------------------------------------------------------------- 
   AIC Estimates (MLE)      C:\Program Files (x86)\TexaSoft\WINKS7\SUN.SDA 
   -------------------------------------------------------------------------- 
 
   Ranges searched  AR: 0 to  10 and  MA: 0 to  3 
 
       P       Q            WNV             AIC 
    -------- -------   ------------   ------------ 
       8      0        212.60278       5.4617    Smallest AIC 
       8      1        211.09674       5.46595 
       6      1        216.19531       5.46709 
       9      0        211.70127       5.46881 
       6      2        214.18143       5.4691 

 
            d) Click Data View at the top of the Output Viewer to return to the Data Editor 

 
Notes about the Output Viewer:   
1. The Output Viewer is in ASCII format that contains output from procedures run in GW-
WINKS.  This file can be saved to a file as a record of the analyses performed. 
2.  At any point in the analysis you can select Output Viewer to the right of the question 
mark on the gray menu bar toward the top of the Data Editor.  Select Data View at the top left 
of the Output Viewer screen to return to the Data Editor.  You can delete the current contents 
of the Output Viewer by selecting Clear Contents at the top left of the Output Viewer Screen.   
3.  By default GW‐WINKS keeps a cumulative record of the analyses that have been 
performed.  At this stage of the current tutorial, at the top of the Output Viewer you will also 
see information about the spectral estimates that were obtained in Step 3. 
4.  If you want to change the default setting to only keep the contents of the most recent 
analysis in the Output Viewer, from the Data Editor screen go to the Help pull down menu, 
select Change Setup Options, and remove the check in the selection box for Append output 
in viewer.  
5.  While in the Output Viewer is open, you can save the contents to a file by going to the 
File menu at the top left of the Output Viewer and choosing Save as.  The file can be saved as 
a .txt, .doc, or .rtf file.  
 
Step 6.  Find ML estimates of the parameters of the AR(8) model 
  a)  On the Time Series Analysis menu select Estimate Parameters   
  b)  Select COUNT as the variable to be analyzed and click Ok 
   c)  Enter 8 in the P= text box, select MLE and click Calculate. 
 

You will again be shown the Output Viewer.  At the bottom of this cumulative record of 
analyses you will find the following output concerning the ML estimates. Note on the factor 
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table at the bottom of the output that the root closest to the unit circle is associated with 
frequency .0968, i.e. period = 1/.0968 = 10.3 years. 

 

       

 d) Click the Data View menu option to return to the Data Editor and observe that 3 
        columns have been added to the sheet:  ARMA_SPECTRUM, ARMA_AUTOCORR and  
          RESIDUALS.  ARMA_SPECTRUM is the autoregressive spectral density estimate  
        associated with the AR(8) model fit to the data, ARMA_AUTOCORR are the  
        theoretical autocorrelations associated with the fitted model, and RESIDUALS contains  
        the residuals from the fitted model. 
 
Step 7. Overlay plots of the AR(8) and Parzen spectral estimates from Step 3 and save the plot to  
  a file. 
  a)  Select the Graphs/Charts menu 
  b)  On this menu select Line/Time Series Plots 
  c)  On the resulting menu select Line plots one or multiple  
   d)  Select the variables PARZEN1, PARZEN2, PARZEN3, and ARMA_SPECTRUM, click Add,  
         and then click Ok. 
  e)  You will see plots of the 4 spectral estimates. 

f)  To overlay these plots:  On the Options menu at the top left of the screen select 
Overlay, specify 4 plots to overlay, and click Ok. The 4 spectral estimates are now  
shown on the same plot, making comparison easy.  Note that for truncation point 70  
(blue curve) the Parzen window (PARZEN2) has several spurious peaks (under- 
smoothed), and for 10M =  the estimate (green curve) is over-smoothed and loses  
important detail.  The AR(8) spectral density (black) and the Parzen spectral  
estimator with 26M = (red) are similar with the primary features being  a distinct  
peak at about  f = .1 and another peak at f = 0.  

 
   Maximum Likelihood Estimates 
   --------------------------- 
 

   Estimated MLE AR Parameters: 
    1) 1.247772           2) -0.496268 
    3) -0.138457           4) 0.177162 
    5) -0.153936           6) 0.074181 
    7) -0.124517           8) 0.206736 
 

   White Noise Variance  = 212.6028 
   AIC                   = 5.461698 
   Iterations            = 35 
 

   AR Factors for MLE Estimates 
  OPERATOR COEFS    ROOT         ABS RECIP    FREQUENCY   
  1 - 1.557B + 0.900B^2    .8653 ± .6021i    0.9486       0.0968     
  1 - 0.883B    1.1331             0.8825       0.0000     
  1 - 0.417B + 0.660B^2    .3163 ± 1.1900i   0.8121       0.2086     
  1 + 0.798B    -1.2538             0.7976       0.5000  
  1 + 0.812B + 0.495B^2   -.8201 ± 1.1611i   0.7035       0.3479     
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g)  To save this plot as a BMP (graphics) file for later use:  On the File menu at  
the top left of the screen select Capture plot as BMP file, select the plot you want to 
capture (in this case there is only one plot), and then choose Capture. You will then 
need to choose a Windows subdirectory and filename for the saved plot.  The overlay 
plot saved by this method is shown here. 

  

 
h) Return to the Data Editor by selecting Return at the top of the plot screen. 

Step 8.    Analyze the residuals of the fit 
     a) Perform the Ljung-Box test:  On the Time Series Analysis  menu, select Ljung/Box test  
         and specify RESIDUALS as the variable, set p=8 and q=0 since this is the 
         order of the model from which these are residuals, and clicking Ok. 
    b) The Output Viewer will be shown to you (you may need to scroll down to see the most 
          recent computations).  You will see the Ljung-Box test which show that   
         the tests at K = 24 and 48 have p-values .3305 and .5106 respectively indicating that  
          there is not sufficient evidence to reject white noise.   
     c)  Click Data View to return to the Data Editor. 

     d)  Check the sample autocorrelations of the residuals 
   i) Compute the sample autocorrelations for the RESIDUALS variable by clicking on  
       Time Series Analysis menu and selecting Sample Autocorrelations.  Then select 
       RESIDUALS as the variable for which sample autocorrelations will be calculated.  
         The sample autocorrelations will be stored in a data editor column with a  
       variable name AUTOCORR_RESIDUA.    

       Note:  Row 1 of the data editor contains the autocorrelation at lag 0 (i.e.1),  row 
        2 contains  the autocorrelation at lag 1, etc.   
   ii)  To plot these data, select the Graphs/Charts menu 
   iii) On this menu select Line/Time Series Plots 
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     iv)  On the resulting menu select Line plots one or multiple  
      v)  Select the variable AUTOCORR_RESIDUA, click Add, and then Ok.   
   vi) You will see the following plot showing sample autocorrelations.  Tutorial 4  
          discusses techniques for editing graphics. In particular, in that tutorial you 
          will be shown how to add 95% limit lines to a sample autocorrelation plot.    

                              

                         vii) Return to the Data Editor by selecting Return toward the upper left of the  
            graphics screen.         
      viii)  To save the expanded data file (containing the calculated variables), click 
             the File menu at the top left of the Data Editor screen and select Save as...  
                           and enter a file name.  For example, entering the name SUN1 will create a  
             file named SUN1.SDA in the current subdirectory. 
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Tutorial 2 – Generating Realizations using GW-WINKS 
 

GW‐WINKS provides a powerful platform from which to generate time series realizations from 
ARMA(p,q) models and from signal-plus-noise models.  This makes an excellent pedagogical 
tool for examining the features of models. 
 
Step 1:   On the Time Series Analysis menu select Generate Realization.  If a data set is currently 
open in the Data Editor, the program will ask you “Erase all data current in the data editor?”     
  a) If the contents of the Data Editor have not been saved and you want to keep them for  
        later use, select Cancel, return to the Data Editor, and save the data before  
       proceeding to Step 2.  (See Step 8, (d) viii in Tutorial 1.) 
  b)  If the contents of the Data Editor have either been saved or will not be  
       needed for future use, proceed to Step 2 
   
Step 2:  Select Ok.  You will see a dialog box such as the following: 

                         
 
This dialog box allows you to specify either a signal-plus-noise model or an ARMA(p,q) model.  
In this tutorial we will discuss the generation of realizations from ARMA(p,q) models.  Notice 
that there are two methods for entering coefficients:  “Entering operators by factors” and 
“Entering operators by coefficients.”  Chapter 3 of the ATSA text discusses factoring ARMA 
models. For convenience, the program “remembers” the most recent model from which 
realizations were generated.  In the dialog box above the most recently used model was the 
AR(2) model 1 21.6( ) .9( )t t t tX X X aμ μ μ− −− − − + − =  where 50μ = , 2 1,aσ =  and the 
realization is length 200.n =   Note that here we use the ARMA(p,q) model notation 
 
 1 1 1 1( ) ( ) ,t t p t p t t q t qX X X a a aμ φ μ φ μ θ θ− − − −− − − − − − = − − −L L  
used in the ATSA text.  (Be careful with signs of coefficients!)   
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In this tutorial we will generate realizations from the ARMA(4,3) model 
 
 1 2 3 4 1 2 3.3 .9 .1 .8 .9 .8 .72 ,t t t t t t t t tX X X X X a a a a− − − − − − −− − − + = + + +  
 

where 2 1aσ =  and from the form of the model we see that 0.μ =   This is the ARMA(4,3) model 
discussed in Example 3.15 in the ATSA text.  In Step 3A we show how to enter a model using 
operator coefficients and in Step 3B we show how to enter factor coefficients. 

Step 3A:  Generating realizations using the operator coefficients. 
  a)  Select ARMA under Generate a Realization section at the top of the entry box  
        (ARMA is the default). 
   b)  Select Enter operator by coefficients in the Time Series Generating Routine section. 
   c)  Enter 4 for P,  3 for Q, and 0 for Mean. 
   d)  In the upper right-hand corner there will be 4 entry lines under P and 3 entry lines  
       under Q.  By default these values are all 1.0.  In the P column enter the values .3, .9,  
       .1, and -.8 (again – be careful with signs) and in the Q column enter -.9, -.8, and -.72.  
  e)  Enter 1 for White Noise Variance, a positive integer (3465 is ok) for Seed, and  
       200 for Series length.   

Note:  If you enter a positive number for Seed, a unique realization is generated each time 
the program is run.  That is, if you use 3465 for the seed and then decide to generate 
another realization from the ARMA(4,3) model and also use the seed 3465, a different 
realization will be generated the second time.  However, if a negative integer is used for 
the seed and later you generate a realization using the same (negative) seed, then the 
second realization is the same as the first. 

  f) The default name for the variable name appears in the Enter variable name to create  
      entry box.  Change this to ARMA43.   The dialog box should look like 
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  g)  Select Create to generate the realization.  The Output Viewer is shown to you, and at  
       the bottom of the Output Viewer you can see information about the model and the  
       realization. 
  h)  On the Graph menu at the top of the screen select Display Graph.  You will see a plot  
       such as the following: 

        

The upper left graph is a plot of the generated realization, the upper right and the lower left are 
plots of the true autocorrelations and spectral density for this ARMA(4,3) model.  The plot on 
the lower right shows the sample autocorrelations based on the generated realization. 
 

  i) Selecting Return at the top left of the screen will return you to the Output Viewer.  
  j) Select Data View to return to the Data Editor.  There you will see the 4 columns of   
      information that were plotted.  Specifically:  ARMA43 contains the realization of  
      length 200, TRUE_AUTOCORR contains true autocorrelations for lags 0 through 249,  
     TRUE_SPECTRUM contains the true ARMA(4,3) spectral density calculated at 251  
      values from f = 0 to  f = .5.  Finally, SAMPLE_AUTOCORR contains sample  
      autocorrelations. 
  k) Using the File menu this data set can be saved by selecting Save as ... and giving  
      the data sheet a name (default is a .SDA file – the primary file mode for GW‐WINKS).  
      You can also save the data in an Excel file (.XLS) or a .CSV file.  This will be  
       discussed further in Tutorial 5. 

Step 3B:  Generating realizations using the factor coefficients. In this step we will generate 
realizations from the same ARMA(4,3) model used in Step 3A but this time we will enter the 
coefficients of the factors.  We assume that Steps 1 and 2 have been run and that a dialog box 
such as the one shown in Step 2 is visible. 
 a)  Select ARMA under Generate a Realization section at the top of the entry box  
       (ARMA is the default). 
   b)  Select Enter operators by factors in the Time Series Generating Routine section. 
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   c)  Enter 4 for P,  3 for Q, and 0 for Mean 
   d)  Underneath the Enter P= and Enter Q= boxes are entry boxes for entering the number  
       of factors.  In this step we will use the factored form of the model, which from  
       Example 3.15 is 
 

                         2 2 2(1 1.8 .95 )(1 1.5 .85 ) (1 .9 )(1 .8 )t tB B B B X B B a− + + + = + + . 
       In the No. Factors box below Enter P=,  type 2.  Similarly, type 2 in the No. Factors  
       box underneath Enter Q= since both the 4th order AR component and the 3rd order MA  
       component of the model are factored into 2 factors.   
  e)  There are two rows of entry boxes under the heading Enter parameters for AR factors 
        (separate with commas).  In the first box enter 1.8,-.95  (don’t forget the comma) 
       and in the second box enter   -1.5,-.85.  Also in the two rows of entry boxes under the 
       heading Enter parameters for MA factors(,), enter -.9 and in the first box  and in the   
       second box enter  0,-.8 (the coefficient on B is zero). 
 

       All other data entry is the same as in Step 3A (beginning with e).  That is, procedures  
       for entering the mean and white noise variance, selecting a sample size, seed, etc. are 
       the same as in Step 3A. 
 

Step 4:  After a realization has been generated (by either Step 3A or 3B for entering the model), 
the model parameters are remembered by GW‐WINKS.  The following steps could be used for 
viewing several realizations from a given model (this can be useful to students and researchers to 
understand the behavior that changes from realization to realization vs. the behavior that stays 
the same).  
  a) Select Data View at the top of the Output Viewer 
  b) Select Time Series Analysis and then Generate Realization 
  b) GW‐WINKS will ask “Erase all data current in the data editor?”  Select Ok and you  
      will see the Generate a Realization dialog box containing the model information you  
      entered in Step 3A or 3B.  (Note: If you want to retain the data from the previous  
      realization you should save it to a file by using Save as ... under the File menu before  
      generating another realization.) 
  c) On the Generate a Realization dialog box select Create.  Note:  As long as the SEED 
       is a positive integer, it need not be changed from realization to  
      realization.   
  d) On the menu at the top of the Output Viewer select Graph and then Display Graph. 
                You will see a plot similar to the one shown for the first realization.  The true  
      autocorrelations and spectral density (upper right and lower left plots) are based on  
      model parameters and will be the same for any realization from this particular model.   
     The realization (upper left plot) and sample autocorrelations (lower right plot) will be  
      different from realization to realization. 
  e)  Select Return to go back to the Output Viewer and then select Data View to return to 
       the Data Editor. 
 

  Step 4 a) through e) can be repeated as many times as desired.  
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Tutorial 3 – Using GW-WINKS Graphics (also using the 
                     Attributes Tab) 

It is important to understand that GW‐WINKS recognizes certain variable names and sets the data 
characteristics accordingly.  The following is a list of variable naming conventions: 

Variable Name Contains   Variable Type Assumed 
       AUTOCORR      Autocorrelations 
       SPECTRUM       Spectral plot 
       BARTLETT       Spectral plot 
       TUKEY        Spectral plot 
       PARZEN       Spectral plot 
       PERIODOGRAM     Spectral plot (using vertical bars) 
 

      All other names       Time series realization 

The windowed spectral estimators (Bartlett, Tukey, and Parzen) as well as true and estimated 
ARMA(p,q) spectral densities are evaluated at 251 values between f = 0 and f = .5.  Thus, when 
plotting a variable whose name indicates that it is one of these types of variables, GW‐WINKS 
assumes that the horizontal axis is frequency and is scaled between 0 and .5.  GW‐WINKS 
evaluates the periodogram at / ,  1,..., / 2jf j n j n= =  if n is even and at / ,  1,...,jf j n j m= =  
where n = 2m + 1 if n is odd.    

In this tutorial we illustrate some of the more advanced capabilities of GW‐WINKS graphics. 

Step 1: Open the TUTORIAL3.SDA data set  
  a) Select Open Data Set from the File menu at the top left of the screen. 
   b) By default the WINKS SDA 6 subdirectory will be shown. 
   c)  Enter TUTORIAL3.SDA in the Filename entry box and click Open.  (You may also  
       select TUTORIAL3.SDA from the list of .SDA files in the subdirectory.) 

Step 2:  This data set has data on 4 variables named VAR1, VAR2, VAR3, and VAR4.  These 
variables contain the following information: 
 

       VAR1: sunspot data used in Tutorial 1 
  VAR2: sample autocorrelations for VAR1 
   VAR3: Periodogram of VAR1 
   VAR4: Parzen spectral density estimator for VAR1 (M=26) 

Step 3: Plot the data 
  a)  Select the Graphs/Charts menu 
  b)  On this menu select Line/Time Series Plots 
  c)  On the resulting menu select Line plots one or multiple  
   d)  Select all 4 of the variables, click Add, and then Ok. 
   e)  You will see the 4 selected plots. 
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Note:  The names VAR1‐VAR4 provided GW‐WINKS with no information concerning 
variable types.  Consequently, all variables were plotted simply as time series realizations. Note 
that the horizontal axis is Time in each of these plots and the axis limits are from 1 to the number 
of data values in the Data Editor for that variable.  In order to plot these variables correctly, we 
will use the Attributes tab.    
 

Step 4:  Select Return at the top left of the graphics screen to return to the Data Editor.   At the 
bottom of the data window, note that there are two tabs:  Data and Attributes.  You can toggle  
 

 
 
back and forth between these two settings by clicking on the tabs.  In this tutorial we will show 
how to use the Attributes mode to change variable names and characteristics.   
 
Step 5:  Select the Attributes tab.  The following will be shown on the screen.  
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Step 6:  The Attributes view of the data shows variable names, variable types , and other 
information.  In this tutorial we will edit the variable names. 
  a)  Change VAR1 to COUNT by double clicking on the cell containing VAR1, using the 
        backspace key to clear the cell, and then typing COUNT.   
  b)  Using the technique in a) 
                   i)  Change VAR2 to AUTOCORR_SUN   
         ii) Change VAR3 to SAMPLE_SPECRUM_SUN  
         iii) Change VAR4 to PARZEN_SUN   
  c)  Return to the Data Editor by clicking on the Data tab at the bottom left. 

Note:  You can change characteristics of the variables such as width and number of decimals.  
These variables are all numeric.  Variables can also be identified as Character  and Date 
variables.  Note that GW‐WINKS automatically sets -9999 as the missing value for any calculated 
variable. 

Step 7: Plot the data as in Tutorial 3, Step 3 
  a)  Select the Graphs/Charts menu 
  b)  On this menu select Line/Time Series Plots 
  c)  On the resulting menu select Line plots one or multiple  
  d)  Select all 4 of the variables, select Add, and then Ok. 
   

The 4 plots should look like the following.  
 

 
 
 

Note that this time the variables are automatically plotted appropriately, i.e. GW‐WINKS 
recognizes AUTOCORR_SUN as autocorrelations and SAMPLE_SPECTRUM_SUN and 
PARZEN_SUN as spectral plots.  
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In the following, we will illustrate some of the graphics editing features.  
 
Step 8:  Editing plots using the Multiple Graph Options dialog box 
a) Right click anywhere on the plot obtained in step 7 to display the Multiple Graph Options 
dialog box shown here. 
 
 

                   
  
Notice the tabs at the top of this dialog box (Data, Axes, Labels, Lines, and Source). By default 
the Multiple Graph Options box comes up under the Data/Ok tab.   Selecting a tab displays plot 
options for that topic.  
 
Step 9:  Using the Data Tab 
This tab controls the selection of plots shown. Note that there are up to 4 Data Source options. 
The plots are displayed in the order you selected them from the Multiple Plots dialog box.  

  a)  To plot only the COUNT and AUTOCORR columns, choose 2 rows and 1 column on the  
                 Select layout dialog box. 
  b)  Select Ok and the plots will be displayed (not shown here).   
  c)  For the remainder of this tutorial we will use the 2 rows, 2 cols layout, so select the  
       2 rows, 2 cols option to continue. 

Step 10:  Using the Axes Tab.  The Axes tab allows you to specify ranges for the x and y axes for 
each plot.  
  a) Right click on the plots to return to the Multiple Plots dialog box  
  b) Select the Axes tab and the following dialog box is shown. 
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c)  COUNT:  These are counts of sunspot numbers.  The plot title is COUNT. A better title  
      would be Sunspot Numbers (1749‐1924).  Make this change in the Plot Title box. 
d)  AUTOCORR_SUN:  These are autocorrelations that go from lag 0 to lag 175.   
  i)   Click on the open circle to the left of AUTOCORR_SUN  
  ii)  Change the X AXIS INFO  to End at 40  
   iii) Change the  by  from 20 to 10 for labeling purposes. 
             iv) Change the Y AXIS INFO to begin at -1 and end at 1 
         v)  Change the Y Axis Label to Autocorrelations 
   vi) Change the Plot Title to Sunspot Sample Autocorrelations 
e)  SAMPLE_SPECTRUM_SUN:  This variable contains the periodogram.  Since the  
      phrase “SPECTRUM” is in the name, the plot is a spectral plot (i.e. the X-axis is  
      frequency.   
  i)   Click on the open circle to the left of SAMPLE_SPECTRUM_SUN  
  ii)  Change the Y‐Axis Label to 10log10 Periodogram 
  iii) Change the Plot Title to Sunspot Periodogram   
f)  PARZEN_SUN:   
  i)   Click on the open circle to the left of PARZEN_SUN  
  ii)  Change the Y‐Axis Label to 10log10 Spectral Density 
  iii) Change the Plot Title to Parzen Window Spectral Density Estimator  (M=26)  
 g) Click Ok at the bottom right and the following plot will be displayed.  
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 Step 11:  Using the Lines tab 
 a)  Right click anywhere on the graph 
 b) Select the Lines tab on the Multiple Graph Options dialog box and you will see  
       the following 
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c)  Plot 1:  In order to display the actual 176 plotted values, select “1. Closed circle” 
     under the heading Type marker at each point leaving all other selections at defaults. 
d)  Plot 3:  To plot the periodogram using the common format of spikes, select 
     Spike@Min in the Plot Type box. 
e)  Select Ok at the bottom of the box and the following will be displayed. 
   

 

     Note:  The periodogram plot as it appears below could also have been obtained by 
     naming the variable PERIODOGRAM_SUN or any other name that includes  
     “PERIODOGRAM” as part of the name.  The use of the name SAMPLE_SPECTRUM_SUN  
     was used here to illustrate the procedure for changing the plot type. 

 f)  Return to the Data Editor by selecting Return at the upper left of the graphics  
       screen. 

Step 12: In this step we will show how to place the 95% limit lines on sample autocorrelations.  
We will fit the same AR(8) model based on ML estimates of the sunspot data that we     
obtained in Tutorial 1.  (The variable COUNT in the current file (TUTORIAL3.SDA) is the same as 
the variable COUNT in SUN.SDA used in Tutorial 1.)  
  a)  On the Time Series Analysis menu select Estimate Parameters   
  b)  Select COUNT as the variable to be analyzed and click Ok 
   c)  Enter 8 in the P= text box, select MLE and click Calculate. 
     d)  Click on the Data View menu option to return to the Data Editor to observe that 3 
        columns have been added to the sheet:  ARMA_SPECTRUM, ARMA_AUTOCORR,  
        and RESIDUALS.   
          The variable RESIDUALS contains the residuals from the fitted model. 
            e)  Compute the sample autocorrelations for the RESIDUALS variable by clicking on  
       Time Series Analysis menu and selecting Sample Autocorrelations.  Then select 
       RESIDUALS as the variable for which sample autocorrelations will be calculated. The 
       sample autocorrelations will be stored in a data editor column with a variable name 
       AUTOCORR_RESIDUA.    
 



WINKS SDA Getting Started Guide  20 
 
 
 f)  To plot the sample autocorrelations of the residuals, select the Graphs/Charts menu 
  g)  On this menu select Line/Time Series Plots 
   h)  On the resulting menu select Line plots one or multiple  
   i)   Select the variable AUTOCORR_RESIDUA, click Add, and then Ok.  You will see the 
       sample autocorrelations that were plotted at the end of tutorial 1.  
  j)  Right click anywhere on the plot to display the Multiple Graph Options dialog box. 
       Select the Lines Tab.  At the bottom of the dialog box is the following:   
           

           AUTOCORR_RESIDUA  Plot#1 appears to be autocorrelations.  Plot 95% CI? Original N= 176 

   k)  Click on the left entry box and enter 176 for N.  The multiple graph dialog box  
         should look like the following after your entries:  

                       
 
  l)  Click Ok and the following plot should appear 
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Note:  When you right click on a plot and select the Lines Tab on the Multiple Graph Options 
dialog box, then you will see a comment such  

                     Plot#1 appears to be autocorrelations.  Plot 95% CI? Original N= 

for any plotted variable that contains AUTCORR somewhere in the name.  However, the plotting 
program does not distinguish between sample autocorrelations and true autocorrelations.  When 
true autocorrelations are plotted, these limit lines are meaningless and should not be plotted.  For 
example, in Tutorial 2, Step 3A, part (h) we show a plot that has true autocorrelations in the 
upper right and sample autocorrelations in the lower right plots. Right clicking on the plot and 
selecting the Lines Tab in the Multiple Graph Options dialog box will result in the selection 
options   
 
  TRUE_AUTOCORR       Plot#2 appears to be autocorrelations.  Plot 95% CI? Original N= 200 

 

  SAMPLE_AUTOCORR     Plot#4 appears to be autocorrelations.  Plot 95% CI? Original N= 200 
 
Since Plot #2 (upper right) shows true autocorrelations, the (sample based) limit lines make no 
sense and should not be plotted.  The “Original N=200” for Plot #2 indicates that 200 true 
autocorrelations were calculated, i.e. there are 200 values in the TRUE_AUTOCORR column.  Of 
course, the sample autocorrelations in Plot#4 will exceed the 95% limit lines for most lags 
indicating (the obvious fact) that the data are not white noise.
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Tutorial 4 – Factor Tables 
 

One of the key tools discussed in ATSA for studying ARMA models is the factor table.  This 
tutorial goes through the steps for using GW‐WINKS to calculate factor tables.  GW‐WINKS allows 
you to (a) enter the coefficients of a model manually in order to find the factors and (b) find the 
factors of an estimated AR model fit to the data.  
 

Step 1:  Entering coefficients manually 
  a) On the Time Series Analysis menu select Factoring Routines   
       Note:  This routine allows a “No Data” mode so it does not matter whether any data  
       are currently in the Data Editor.   
  b)  If the Data Editor contains no data, then you will see a dialog  
       box such as 
 

                                        
                                         

         If the Data Editor contains data, the variable names will appear in the dialog box 
         above PROCEED NO DATA. 
 

 c) In either case (if the Data Editor contains data or not) select PROCEED NO DATA and  
      Ok.  You will see the following data entry screen. 
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            d)  Enter 4 as the Number of AR Coefficients, and then enter: .3, .9, .1, and -.8 in the 4  
       entry boxes. 
 
  e) Select Calculate and you will see the following screen which shows the factor table 
      that was previously given in Table 3.6 of the ATSA text.  It can also be seen that the  
      factors 21 1.8 .95B B− +  and 21 1.5 .85B B+ +  (after rounding) are the ones used in  
      Tutorial 2. 
 

                          
 
 

  f)  Selecting Exit takes you to the Output Viewer and selecting Data View returns you to  
       the Data Editor. 

Step 2:  Finding Factor Tables for an estimated model (assuming that TUTORIAL3.SDA is in the 
Data Editor) 
            a)  Open the SUN.SDA data set  
       i) Select Open Data Set from the File menu at the top left of the screen. 
        ii) By default the WINKS SDA 6 subdirectory will be shown. 
        iii)  Enter SUN.SDA in the Filename entry box and click Open.   
  b)   On the Time Series Analysis menu select Factoring Routines   
  c)  You will see the dialog box similar to the one shown in part (b) of Step 1 of this  
        tutorial except that COUNT now shows in the list of available variables. This 
        time select COUNT and Ok.  You will see the following: 
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  c)  Select Calculate Burg Estimates, enter 8 when you are asked for the model order, and  
        click Ok. 
  d)  You will see a screen with the 8 AR coefficients.  These are the Burg estimates for an  
        AR(8) fit to the sunspot data.  Select Calculate to obtain the corresponding factor  
        table displayed here. 
 

                       
 
      Note that as expected the factor with roots closest to the unit circle is associated with a 
      frequency of about f = .1.   
  e)  Select Create Additive Components at the bottom right o calculate the additive  
       components associated with the fitted model.   (See Section 3.4 of ATSA)   
  f)  Select Data View and in the Data Editor and you will see that 5 new variables (F1 – F5)  
       have been created. Variable Fk is the additive component associated with the kth  row 
       of the factor table.   
  g)  To plot VAR1 (the sunspot data) along with the first 3 additive components (F1 – F3) 
   i)  Select the Graphs/Charts menu 
   ii)  On this menu select Line/Time Series Plots 
     iii)  On the resulting menu select Line plots one or multiple  
     iv)  Select VAR1, F1, F2, and F3 and click Ok.   
          You will see the following plots. 
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h)  In order to plot all components on the same vertical scale 
  i)  Right click anywhere on the plot 
  ii)  Select the Axes tab on the Multiple Graphs Options dialog box 
  iii) For each of the variables, click the Select Plot button, and set the Y-Axis limits to  
          begin at -50 and to end at 180 and to increment by 20. 
  v)  Select Ok and you will see the plots 
 

                  
 

        In these plots it can be seen that the first component (F1) describes the cyclic behavior 
        and that the second component (F2) seems to model the variability in peak heights.  
        The third component (F3) seems to model a weak high frequency behavior. 
 
  i)  Select Return at the top left of the Graph sheet to return to the Data Editor. 
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          Tutorial 5: Preparing Data for GW-WINKS 
The native file format for GW‐ WINKS is an .SDA file. GW‐ WINKS can also read .DBF, Excel 
(.XLS) and text files (.CVS, .TXT, .DAT etc.).  
 

Time series data are recorded as a series of data values. In GW‐ WINKS (as in most statistical 
software) the data are recorded as one observation per record. This tutorial discusses several 
ways to enter data into GW‐WINKS .  

Importing Data from a Text File (.txt, .csv, .dat) 
 

Consider the text file AIRLOG.TXT file which is shown here as it would look in Microsoft 
Notepad. 
 

                             

Observe that the first row of the data set contains the name LOGPASS followed by the values of 
the series. This data set contains the natural logarithms of the classical airline passenger data 
(monthly data for 12 years).  To open this data set in GW‐WINKS 
 
  a)  Select Open Data Set from the File menu at the top left of the GW‐WINKS screen. 
  b)  By default the WINKS SDA subdirectory will be shown. 
  c)  Enter AIRLOG.TXT in the Filename entry box and click Open 
                 (Alternatively, in the Files of type entry box you can choose .csv, .dat, .txt Text files  
        (Comma separated), then select AIRLOG.TXT from the list of, and click Open.) 
   d) You will be asked if the first row in the file AIRLOG.TXT contains the variable  
         name. Since the first row contains the name LOGPASS select Yes and click Ok 
 

The data are now opened in GW‐ WINKS. Note that the name LOGPASS is the variable name used 
by GW‐WINKS.  Inserting the variable name as the first value in a .txt file is optional.  If the data 
in AIRLOG.TXT simply began with the first data value (i.e. 4.7185) in line 1 (instead of LOGPASS), 
then by default GW‐WINKS would assign the variable name VAR1.   
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We recommend that you do the following to save the data file in the native .SDA format: 
 
  a)  Select Save as...  from the File menu.   
  b)  Enter the name AIRLOG.SDA in the Filename entry box 
  c)  Click Save 

To change attributes of variables such as variable type (number, character), number of decimal 
places, and missing values, click on the Attributes tab at the bottom of the GW‐ WINKS Data 
Editor window. The use of this feature is more fully described in Tutorial 3 and WINKS Help. 

 
Importing Data from an Excel File 

GW‐ WINKS can also import data from Microsoft Excel files. The data to be imported must be in 
an acceptable format. For example, the file SUN.XLS contains annual sunspot numbers from 1749 
to 1924 (the same data as in SUN.SDA that was used earlier). The first part of that Excel file is 
shown here.   

 

Observe that the variable name (COUNT) is in the first row of the Excel data file (again - 
optional) followed by the values of the series.  
 
To open this data set in GW‐WINKS,  
 a)  Select Open Data Set from the File menu at the top left of the GW‐WINKS screen. 
  b)  By default the WINKS SDA subdirectory will be shown. 
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  c)  Enter SUN.XLS in the Filename entry box and click Open 
                 (Alternatively, in the Files of type entry box you can choose .xls Excel 97 or newer,  
                   then select SUN.XLS from the list of .xls files and click Open.)  
   d)  At this point GW-WINKS shows a dialog box asking which sheet in the Excel file to 
        open since Excel files can contain more than one worksheet).  In this case the only 
        worksheet is shown as  1) Data .  Click Import. 
   e)  You will be asked if the first row contains the variable name.  Since the first row in  
       SUN.XLS contains the name COUNT select Yes.  You will see the GW‐WINKS Data  
          Editor screen that looks like  

                                     

Note: GW‐ WINKS can read Excel files from version 97 to 2003.  If you are using Excel 2007 or 
2010, go to Excel and save the data (Save As) in the older .XLS version (rather than .XLSX) before 
opening the data file in GW‐ WINKS. (You could also simply copy the data in your Excel file and 
paste them into the GW‐ WINKS Data Editor, then save the file in the GW‐ WINKS.SDA format.) 

More information 
 

GW‐WINKS has other features such as forecasting that are not described in these tutorials.  In the 
ATSA text, short discussions in paragraphs headed by Using GW‐WINKS are given throughout 
the book that discuss how to use GW‐WINKS to perform analyses. 
 

To display the WINKS Users Guide, in the GW‐WINKS main Data Editor page, click on Help/ 
Help on the Web/Internet, and from the displayed web page, click on  

WINKS SDA 7 Manual   

To see a Getting Started Guide for the full WINKS (non-time series) software, go to  

http://www.texasoft.com 

and click on Getting Started Guide, Version 7.  


